EPSON
EXCEED YOUR VISION
Ultra Hi-Definition
R260 Photo Printer
Photos | CDs | Documents

Printer Basics
Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as applied to other equipment.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Responsible Use of Copyrighted Materials

Digital cameras, scanners, and ink jet printers, like conventional photocopiers and cameras, can be misused by improper copying or printing of copyrighted material. While some countries' laws permit limited copying of copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. Epson encourages each user to be responsible and respectful of the copyright laws when using digital cameras, scanners, and ink jet printers.

Trademarks

Epson, Epson Stylus, and MicroPiezo are registered trademarks; Claria, Exceed Your Vision, USB DIRECT-PRINT, and the USB DIRECT-PRINT logo are trademarks of Seiko Epson Corporation.

RPM and BorderFree are registered trademarks; PhotoEnhance is a trademark; and Epson Connection and Epson Store are service marks of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.

© 2007 Epson America, Inc.
# Contents

**Welcome** ................................................................. 5  
Exif Print ......................................................................... 5  
About Your Documentation ............................................. 6  

**Printing From Start to Finish** ........................................ 7  
Loading Paper .................................................................... 7  
Printing in Windows .......................................................... 11  
  Selecting Default Settings ................................................ 14  
Printing With a Macintosh .................................................. 15  
Selecting the Correct Paper Type ....................................... 19  
Printing Borderless Photos ............................................... 20  
  Storing and Displaying Your Prints ................................. 21  
  Windows Vista .................................................................. 21  
  Windows XP .................................................................... 23  
  Macintosh ....................................................................... 26  
Printing on CDs and DVDs ............................................... 28  
  Cleaning the Rollers ....................................................... 28  
  Inserting a CD or DVD .................................................... 28  
  Designing and Printing in Windows ............................... 31  
  Designing and Printing on a Macintosh ......................... 36  
Direct Printing from a Digital Camera or Mobile Phone ..... 41  
  Connecting and Printing ................................................ 41  

**Maintaining Your Printer** ............................................... 43  
Cleaning the Print Head .................................................... 43  
  Checking the Print Head Nozzles ..................................... 43  
  Running the Head Cleaning Utility ................................. 44  
Replacing an Ink Cartridge ................................................. 46  
  Checking the Ink Supply ................................................ 46  
  Purchasing Ink Cartridges .............................................. 48  
  Ink Cartridge Precautions .............................................. 49
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Removing and Installing Ink Cartridges</td>
<td>50</td>
</tr>
<tr>
<td>Aligning the Print Head</td>
<td>54</td>
</tr>
<tr>
<td>Cleaning the Printer</td>
<td>55</td>
</tr>
<tr>
<td>Transporting the Printer</td>
<td>56</td>
</tr>
<tr>
<td><strong>Solving Problems</strong></td>
<td>57</td>
</tr>
<tr>
<td>Diagnosing Printer Problems</td>
<td>57</td>
</tr>
<tr>
<td>Running a Printer Check</td>
<td>59</td>
</tr>
<tr>
<td>Problems and Solutions</td>
<td>60</td>
</tr>
<tr>
<td>Setup and Software Installation Problems</td>
<td>60</td>
</tr>
<tr>
<td>Printer Problems</td>
<td>61</td>
</tr>
<tr>
<td>Print Quality Problems</td>
<td>62</td>
</tr>
<tr>
<td>Problems With Paper or CD/DVD Tray Feeding</td>
<td>64</td>
</tr>
<tr>
<td>CD/DVD Printing Problems</td>
<td>65</td>
</tr>
<tr>
<td>Miscellaneous Printout Problems</td>
<td>66</td>
</tr>
<tr>
<td>Uninstalling Printer Software</td>
<td>67</td>
</tr>
<tr>
<td>Windows</td>
<td>67</td>
</tr>
<tr>
<td>Macintosh</td>
<td>68</td>
</tr>
<tr>
<td>Where To Get Help</td>
<td>69</td>
</tr>
<tr>
<td>Epson Technical Support</td>
<td>69</td>
</tr>
<tr>
<td>Purchase Supplies and Accessories</td>
<td>69</td>
</tr>
<tr>
<td><strong>Requirements and Notices</strong></td>
<td>70</td>
</tr>
<tr>
<td>Windows System Requirements</td>
<td>70</td>
</tr>
<tr>
<td>Macintosh System Requirements</td>
<td>70</td>
</tr>
<tr>
<td>Important Safety Instructions</td>
<td>71</td>
</tr>
<tr>
<td>Ink Cartridge Safety Instructions</td>
<td>72</td>
</tr>
<tr>
<td>FCC Compliance Statement</td>
<td>73</td>
</tr>
<tr>
<td>Declaration of Conformity</td>
<td>74</td>
</tr>
<tr>
<td>Epson America, Inc. Limited Warranty</td>
<td>75</td>
</tr>
<tr>
<td><strong>Index</strong></td>
<td>77</td>
</tr>
</tbody>
</table>
Welcome

Your Epson Stylus® Photo R260 is a full-featured printer. With its exceptional speed and print resolutions, you can print superior photographs and use it for all of your everyday printing, plus print directly onto CDs and DVDs. It provides you with these advanced features:

- Claria™ Hi-Definition ink, for the ultimate combination of photo quality and longevity
- Automatic photo correction when printing from Windows®
- Smooth gradations and sharp detail with Epson's patented MicroPiezo® print head and DX5 technology
- Printing on ink jet-printable CDs and DVDs
- True BorderFree® frame-ready prints on select 4 × 6, 5 × 7, 8 × 10, and letter-size papers
- PictBridge™ printing directly from your digital camera or mobile phone

Exif Print

The Exif (Exchangeable Image File) Print format includes information about your digital camera settings in JPEG/TIFF files so your printer and application can use them to create accurate print settings. Most digital cameras store Exif Print information such as shutter speed, metering, flash, exposure settings, resolution, and lens use in the JPEG/TIFF image file. Your printer uses the information to ensure the most accurate image reproduction.
About Your Documentation

To set up your printer and install its software, see the Start Here sheet.

This book contains instructions on loading paper, printing with Windows and Macintosh® printing borderless photos, printing on CDs and DVDs, direct printing from a digital camera or mobile phone, maintaining your printer, and solving basic problems.

For more information about your printer, double-click the Stylus Photo R260 User’s Guide icon on your desktop.

Please follow these guidelines throughout:

**Warning:**
Warnings must be followed carefully to avoid bodily injury.

**Caution:**
Cautions must be observed to avoid damage to your equipment.

**Note:**
Notes contain important information about your printer.

**Tip:**
Tips contain hints for better printing.
Loading Paper

The type of paper you choose affects the way your printout looks, so be sure to select the correct paper for your job. If you are just printing a rough draft, plain paper is fine.

For the best results, you'll want to use one of Epson’s special ink jet papers designed for your printer. For example, your photos will look great printed on Epson Ultra Premium Photo Paper Glossy. See “Selecting the Correct Paper Type” on page 19 for more information.

Follow these steps to load paper in your printer.

1. Open the paper support and slide out its extension.

2. Open the front cover and slide out the front tray extensions.
3. Make sure the front tray is in the paper (lower) position. If it is not, push the tray lever up to reposition the front tray.

Caution:
Before you move the tray lever, make sure no paper or other objects are on the front tray and the front tray is not extended.

Do not touch the front tray when you move the tray lever.

Do not move the tray lever while the printer is printing.

4. Insert paper, printable side up, against the right edge guide and behind the tab.

You can load up to 120 sheets of plain paper or up to 20 sheets of photo paper. (See page 10 for capacity guidelines on other paper types.)
5. Slide the left edge guide against the paper (but not too tightly).

- Leave enough space in front of the printer for the paper to be fully ejected.
- Don't load paper above the arrow mark on the left edge guide.
- Load the printable side face-up. It's often brighter or whiter than the other side.
- Always load the short edge first, even when printing in landscape mode.
- Load letterhead or preprinted paper into the printer top edge first.
- If you experience paper feeding problems, try loading fewer sheets.
- If you're using special paper, follow the instructions that came with it.
When you load Epson® ink jet papers, follow these loading capacity guidelines:

<table>
<thead>
<tr>
<th>Paper name</th>
<th>Loading capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>100 sheets</td>
</tr>
<tr>
<td>Epson Photo Quality Ink Jet Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Bright White Paper</td>
<td>80 sheets</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>20 sheets</td>
</tr>
<tr>
<td>Epson Ultra Premium Glossy Photo Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Glossy Photo Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semigloss</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Semigloss Photo Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td></td>
</tr>
<tr>
<td>Epson Glossy Photo Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td></td>
</tr>
<tr>
<td>Epson Matte Paper Heavyweight</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-Sided</td>
<td></td>
</tr>
<tr>
<td>Epson Double-Sided Matte Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Luster</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Luster Photo Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Iron-on Cool Peel Transfer paper</td>
<td>1 sheet</td>
</tr>
<tr>
<td>Epson Photo Quality Self Adhesive Sheets</td>
<td></td>
</tr>
</tbody>
</table>
Printing in Windows

Follow the instructions in this section to print a document or photo using basic print settings. For instructions on printing borderless photos, see page 20. For instructions on printing with Advanced print settings, see your on-screen User’s Guide.

1. From the File menu, click Print.

2. Make sure EPSON Stylus Photo R260 Series is selected.

3. Click the Properties or Preferences button. (If you see a Setup, Printer, or Options button, click it. Then click Properties or Preferences on the next screen.)
You see the basic print settings window:

4. Select from these **Quality Option** settings:
   - **Draft**: For rough drafts with reduced print quality
   - **Text**: For text-only documents with higher text quality
   - **Text & Image**: For documents with text and images with higher quality
   - **Photo**: For photos and graphics with good quality and speed
   - **Best Photo**: For photos or graphics with high print quality

5. Make sure the paper Type and Size settings match the paper you've loaded in the printer. See “Selecting the Correct Paper Type” on page 19.

6. Select **Portrait** or **Landscape** for the Orientation setting.
7. For more printing options, click the Advanced button. Then select the following settings as necessary.

- Select a color management method
  (To choose No Color Adjustment, click ICM first)

- Select Paper & Quality Options as necessary

- Click here to select your quality option

- Select Print Options as necessary

**Note:**
For the highest quality on selected papers, you can select Photo RPM (5760 x 1440) from the quality option pop-up menu (as shown above). When you select Photo RPM, printing will take longer.

For more information about advanced settings, or instructions on saving them as a group so you can reuse them later, click the Help button or click the ? button and then click on the area you need help with.

8. If you want to change the layout settings, click the Page Layout tab and select settings as necessary.

9. Click OK to confirm your settings, then click OK or Print to start printing.
During printing, the following window appears and shows the progress of your print job. You can use these buttons to cancel, pause, or resume printing. You can also see how much ink you have left.

**Tip:**
You can also cancel printing by pressing the paper button on your printer.

**Selecting Default Settings**

Your printer settings only apply to the program that you’re currently using. If you want, you can change the Windows default printer settings for all your programs.

1. Right-click the printer icon in the lower right corner of your screen (taskbar).
2. Select **Printer Settings**. You see the window shown on page 12.
3. Select the default settings you want for all your applications, then click **OK**.

You can still change the printer settings in your program, if necessary.
Printing With a Macintosh

Follow the instructions in this section to print a document or photo using basic print settings. For instructions on printing borderless photos, see page 20. For instructions on printing with Advanced print settings, see your on-screen User's Guide.

Before you begin, make sure you added your printer to the Printer Setup Utility or Print Center as described on the Start Here sheet.

1. From the File menu, select Page Setup. You see the Page Setup window:

2. Select Stylus Photo R260 from the Format for pop-up menu.
4. Click OK to close the Page Setup window.
5. From the File menu, select Print. You see a window like this one:

6. Select Stylus Photo R260 from the Printer pop-up menu.
7. Select **Print Settings** from the pop-up menu.

8. Select the following Print Settings as necessary:

![Print Settings Diagram]

9. You can also choose other print settings by selecting these options in the pop-up menu:
   - **Copies & Pages**: Select the number of copies or a page range.
   - **Layout**: Select page layout options.
   - **Output Options** (Mac OS X 10.2.x or 10.3 only): Save your print job as a PDF file. In Mac OS 10.4.x, click the **PDF** button instead.
   - **Scheduler**: Schedule your print job to print at a later time.
   - **Paper Handling**: Select page printing options, such as Reverse print order.
   - **Cover Page** (Mac OS X 10.4.x only): Print a cover page before your document or photo.
   - **ColorSync** or **Color Management**: Select ColorSync® or adjust the color controls or gamma setting, or turn off color adjustments in the printer software.
   - **Expansion**: Reduce or enlarge the image size for borderless printing.
■ **Extension Settings:** Select a wider platen gap if ink smears on sheets or envelopes.

■ **Summary:** View a list of all your selections.

**Note:**
For more information about printer settings, click the ? button.

10. Click the **Advanced** button to change the Print Quality, High Speed, or Mirror Image settings.

```
Printer: Stylus Photo R260
Presets: Standard

Page Setup: Standard
Media Type: Plain Paper / Bright White Paper
Color: Color

Mode: Automatic
Advanced
Print Quality: Normal

High Speed
Mirror Image
```

**Note:**
For the highest quality on selected papers, you can select **Photo RPM** (5760 x 1440) from the Print Quality pop-up menu. When you select **Photo RPM**, printing will take longer.

11. Click **Print** to start printing.

12. To monitor the progress of your print job, click the printer icon when it appears in the dock on the bottom of your desktop.

If you’re using Mac OS X 10.2.x, click the Print Center icon instead, then double-click **Stylus Photo R260** in the Printer List window.
The following window appears and shows the progress of your print job. If necessary, you can click the print job to select it, then use these buttons to cancel, pause, or resume printing.

**Tip:**
You can also cancel printing by pressing the paper button on your printer.

13. When you're finished, close the printer window or Print Center.
## Selecting the Correct Paper Type

Select the correct paper **Type** or **Media Type** setting so your printer knows what kind of paper you're using and adjusts the ink coverage accordingly.

<table>
<thead>
<tr>
<th>For this paper</th>
<th>Select this paper Type or Media Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Plain Paper / Bright White Paper</td>
</tr>
<tr>
<td>Epson Premium Bright White Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Iron-on Cool Peel Transfer paper</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Ultra Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Ultra Premium Glossy Photo Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semigloss</td>
<td>Premium Photo Paper Semi-Gloss</td>
</tr>
<tr>
<td>Epson Premium Semigloss Photo Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Glossy Photo Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>Premium Presentation Paper Matte</td>
</tr>
<tr>
<td>Epson Matte Paper Heavyweight</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-Sided</td>
<td></td>
</tr>
<tr>
<td>Epson Double-Sided Matte Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>Presentation Paper Matte</td>
</tr>
<tr>
<td>Epson Photo Quality Ink Jet Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Quality Self Adhesive Sheets</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Luster</td>
<td>Ultra Premium Photo Paper Luster</td>
</tr>
<tr>
<td>Epson Premium Luster Photo Paper</td>
<td></td>
</tr>
<tr>
<td>Envelopes</td>
<td>Envelope</td>
</tr>
</tbody>
</table>
# Printing Borderless Photos

You can print your photos with no margins, extending the image all the way to the edges of the page.

Although borderless printing is a bit slower, you get beautiful snapshots and enlargements, without trimming, on these papers and sizes:

<table>
<thead>
<tr>
<th>Paper name</th>
<th>Sizes</th>
<th>Paper Type or Media Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>4 × 6 inches</td>
<td>Ultra Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Ultra Premium Glossy Photo Paper</td>
<td>Letter (8.5 × 11 inches)</td>
<td>Ultra Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>4 × 6 inches</td>
<td>Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Premium Glossy Photo Paper</td>
<td>5 × 7 inches</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8 × 10 inches</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semigloss</td>
<td>4 × 6 inches</td>
<td>Premium Photo Paper Semi-Gloss</td>
</tr>
<tr>
<td>Epson Premium Semigloss Photo Paper</td>
<td>Letter (8.5 × 11 inches)</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>4 × 6 inches</td>
<td>Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Glossy Photo Paper</td>
<td>Letter (8.5 × 11 inches)</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>8 × 10 inches</td>
<td>Premium Presentation Paper Matte</td>
</tr>
<tr>
<td>Epson Matte Paper Heavyweight</td>
<td>Letter (8.5 × 11 inches)</td>
<td></td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Epson Photo Quality Ink Jet Paper</td>
<td>Letter (8.5 × 11 inches)</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Luster</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Epson Premium Luster Photo Paper</td>
<td>Letter (8.5 × 11 inches)</td>
<td>Ultra Premium Photo Paper Luster</td>
</tr>
</tbody>
</table>
Storing and Displaying Your Prints

With proper care, photographs from your Epson Stylus printer will last for many years. The special Epson Claria inks designed for your printer provide the ultimate combination of photo quality and longevity when used with Epson papers for prints that are properly displayed or stored. For best results, always use Epson papers.

As with traditional photos, Epson recommends proper care that will minimize color changes and lengthen display life:

- Frame prints under glass or a protective plastic sleeve to protect them from atmospheric contaminants like humidity, smoke, and high levels of ozone.
- As with all photographs, keep your prints away from direct sunlight.
- Keep your prints away from high temperature.
- For proper storage, keep your prints in a photo album or plastic photo storage box in acid-free, archival sleeves commonly available from most camera stores.
- Always keep unused paper in the original package.

Windows Vista

You can print your photos from an imaging application or you can use the Windows Photo Gallery in Windows Vista.

1. Locate the photo you want to print on your computer.
2. Right-click the photo, highlight Open With, and select Windows Photo Gallery.
You see the following screen:

3. Click the Print icon at the top of the screen, then select Print.

4. Make sure your printer is selected, then choose the size and type of paper that you loaded in the printer.
Note:
If you’re not sure which paper type to select, see the table on page 20.

5. Click Options in the lower right corner of the screen and select Printer Properties.

6. When you see your printer’s properties window, select Photo as the Quality Option setting.

7. Click the Borderless check box. Read the message and click OK.

8. Click the Page Layout tab. If necessary, adjust the Expansion slider in the Borderless box to choose Max, Min, or the in-between setting.

Min retains the entire image in your print, but there may be a small white edge on the borders of the print. Max expands the image to ensure that there are no unprinted edges, but the edges of the image may not appear in the print.

9. Click OK.

10. When you see the Windows Photo Gallery again, click Print.

Windows XP

1. Locate the photo you want to print on your computer.

2. Right-click the photo, highlight Open With, and select Windows Picture and Fax Viewer.
3. Click the Print icon at the bottom of the screen.
4. Click Next. You see a Picture Selection window:

![Picture Selection Window]

5. Select the photo(s) you want to print and click Next. You see the Printing Options window:

![Printing Options Window]

6. Make sure EPSON Stylus Photo R260 Series is selected, then click Printing Preferences.
You see the following window:

7. Select **Photo** as the Quality Option setting.
8. Select one of the following as the paper Type setting:
   - Ultra Premium Photo Paper Glossy
   - Premium Photo Paper Glossy
   - Photo Paper Glossy
   - Presentation Paper Matte
   - Premium Photo Paper Semi-Gloss
   - Ultra Premium Photo Paper Luster
   - Premium Presentation Paper Matte

   **Note:**
   If you’re not sure which Type to select, see the table on page 20.

9. Click the **Borderless** check box. Read the message and click **OK**.

   **Note:**
   If you need to adjust the amount of image expansion necessary for borderless printing, click the **Page Layout** tab and adjust the **Expansion** slider.

10. Select your paper **Size** setting.
11. Select your photo orientation.
12. Click OK.
13. At the Photo Printing Wizard screen, click Next. You see a Layout Selection window:

14. Select Full page photo print and click Next to begin printing.

**Macintosh**

1. Start your photo program and open your photo.
2. From the File menu, select Page Setup. You see the Page Setup window:

   3. Select Stylus Photo R260 from the Format for pop-up menu.
   4. Select a borderless Paper Size.
   5. Select your photo orientation.
6. Click OK to close the Page Setup window.
7. From the File menu, select Print.

8. Select Stylus Photo R260 in the Printer pop-up menu.
9. Select Print Settings from the pop-up menu.
10. Select one of the following as the Media Type setting:
    - Ultra Premium Photo Paper Glossy
    - Premium Photo Paper Glossy
    - Photo Paper Glossy
    - Presentation Paper Matte
    - Premium Photo Paper Semi-Gloss
    - Ultra Premium Photo Paper Luster
    - Premium Presentation Paper Matte

   **Note:**
   If you're not sure which Media Type to select, see page 20.

11. Select Quality using the slider.

   **Note:**
   If you need to adjust the amount of image expansion necessary for borderless printing, select Expansion from the pop-up menu and adjust the Expansion slider.

12. Click Print to start printing.
Printing on CDs and DVDs

Your printer includes a special tray that lets you print customized text, graphics, and photos directly on any ink jet-printable CD or DVD. The Epson Print CD software makes it easy to import your own photos, add text, and modify your designs with a variety of special effects. You can print on both regular 12-cm and 8-cm mini CDs and DVDs.

Caution:
Use only ink jet-printable CDs and DVDs for printing. Thermal-printable and regular CDs and DVDs should not be used with this printer; otherwise the ink may smear.

Follow the steps in these sections to print on CDs or DVDs:

- “Cleaning the Rollers” on page 28
- “Inserting a CD or DVD” on page 28
- “Designing and Printing in Windows” on page 31
- “Designing and Printing on a Macintosh” on page 36

Cleaning the Rollers

Before you print on CDs or DVDs, it’s a good idea to clean the rollers inside your printer. You can do this by feeding and ejecting several sheets of plain paper.

1. Make sure your printer is turned on and several sheets of letter-size paper are loaded.
2. Press the paper button to feed a sheet of paper through the printer.
3. Repeat step 2 several times.

Inserting a CD or DVD

Make sure the data, music, or video is burned on your ink jet-printable CDs or DVDs before you print. Otherwise, dirt or scratches on the surface may cause errors when you burn the data.
Before you insert a CD or DVD, make sure the printer is turned on. Otherwise, the disc may not be positioned correctly. Then follow these steps:

1. Open the front cover, then set the front tray to the CD/DVD position by pulling the tray lever down.

   Caution:
   Before you move the tray lever, make sure no paper or other objects are on the front tray and the front tray is not extended.
   Do not touch the front tray when you move the tray lever.
   Do not move the tray lever while the printer is printing.

2. Place the CD or DVD on the CD/DVD tray with the white or printable side face-up. Make sure the disc lies flat in the tray.

   Note:
   Use one CD/DVD at a time.

   Caution:
   Before you position the CD or DVD, make sure that no dust or dirt is on the CD/DVD tray, as this may damage the disc's data side.
   Be sure to use the CD/DVD tray provided with this printer. If you use another CD/DVD tray, there may be a gap in the print position and printing may not be performed properly.
To print on a small CD or DVD (8-cm), place the small CD/DVD adapter on the tray first, then place the CD or DVD inside the adapter.

**Caution:**
Make sure you always use the small CD/DVD adapter when you print on 8-cm CDs or DVDs and that the CD or DVD and adapter lie flat on the tray; otherwise the printer may be damaged.

3. Gently insert the CD/DVD tray along the base of the front tray until the marks on the CD/DVD tray and the front tray match each other.

**Caution:**
Make sure both sides of the CD/DVD tray slide underneath the brackets on the front tray.

Do not insert the CD/DVD tray while the printer is printing; otherwise, your printer may be damaged or the surface of the CD or DVD may become dirty or scratched.
4. Follow the instructions in “Designing and Printing in Windows” below or “Designing and Printing on a Macintosh” on page 36 to design and print with Epson Print CD.

**Designing and Printing in Windows**

You can use Epson Print CD to create and print a disc design with images, graphics, and text.

**Designing a CD or DVD**

1. Click Start, point to Programs or All Programs, select EPSON Print CD, then select EPSON Print CD again.
2. To add a background image, click the background icon. You see a window like this:

   ![Select Background Window]

   **Note:**
   If you have already chosen a background, you see a different screen. Click Select Image.

3. To select one of your own images, click the File tab, click **Browse** to locate the folder your images are stored in, then click OK. You see thumbnail images of all the files in the folder.
4. Select your image and click OK.
5. To add text, click the ABC button. Enter your text and use the tabs to apply formatting and special effects, then click OK. (To open the window again, double-click any block of text.)

6. To curve a single line of text, click the text in the main window and drag the red “handle” up or down. Then adjust it using the other handles that appear.

7. When you’re finished, choose Save as from the File menu to save your file.

   **Note:**
   For additional help with Epson Print CD, open the Help menu in Epson Print CD and select Help Topics.

### Printing on a CD or DVD

After you have created your design and loaded a CD or DVD, you’re ready to print.

1. Open the File menu and select Print.
2. Make sure EPSON Stylus Photo R260 Series is selected.
3. Select CD/DVD or CD/DVD Premium Surface as the Media Type setting.
4. Select None as the Print Confirmation Pattern setting.
5. Click Print.

Note:
You can only print on one CD or DVD at a time. When the copies setting is set to 2 or more, remove each CD or DVD from the tray after it has been printed, and then place the next CD or DVD on the tray (see “Inserting a CD or DVD” on page 28 for loading instructions). Then press the OK paper button to resume printing.

After you print, handle the CD or DVD carefully. To allow the ink to dry, wait at least 24 hours before playing the disc or inserting it in a drive. Keep printed discs away from moisture and direct sunlight.

If you need to adjust the print position or color, see “Adjusting the Print Position” below or “Adjusting the Print Density” on page 35.

Adjusting the Print Position

If your printed images and text are not centered or positioned the way you want on your CD or DVD, you may need to adjust the printing position. You can also use these steps to check the position before you print on a CD or DVD.

1. Place an extra ink-jet printable CD or DVD on the CD/DVD tray and insert it into the printer, as described on page 28.
2. Start Epson Print CD.
3. Open the File menu and select Print.

![Click Print Position Confirmation Pattern]
4. Make sure **EPSON Stylus Photo R260 Series** is selected, then click **Print Position Confirmation Pattern**.

5. Click **Print**. The confirmation pattern is printed on the CD or DVD.

6. Remove the CD or DVD and measure the distance from the edge of the hole to the small cross marks labeled **Top** and **Right**. You'll need a metric ruler with millimeters for accurate measurements.

7. Open the File menu, select **Print**, then select **Adjust Print Position**. You see a screen like this:

8. Click **Enter Values**, then input the Top distance (from your measurement) in the Height (Top) box. Enter the Right distance (from your measurement) in the Width (Right) box.

9. Click **OK** to save the measurements.
Adjusting the Print Density

If ink smears on your printed CDs or DVDs, you may need to adjust the color saturation or ink density. CDs and DVDs from different manufacturers may absorb ink differently, so you may need to adjust the density for each type of disc. Follow these instructions to print a color saturation check pattern, and then make adjustments as necessary.

1. Start Epson Print CD.
2. Open the File menu and select Print.
3. Insert a test CD or DVD for printing, as described on page 28.
4. Make sure EPSON Stylus Photo R260 Series is selected, then click Print Density Confirmation Pattern.
5. Click Print.
6. After the pattern is printed, examine the print.
   
   If you need to adjust the color, open the File menu, select Print, and make the Print Color Correction setting lighter or darker as necessary. Then, repeat steps 3 through 6 (but select either Second or Third in the Print Confirmation Pattern section, depending on whether you’re printing your second or third pattern on the disc).
   
   Note:
   You can print three density patterns on one disc. Each pattern is printed in a different location.

7. Remove the CD or DVD and let it dry for at least 24 hours. Then check the saturation levels again.

   Note:
   You can also use the Brightness and Contrast settings in Epson Print CD to adjust color saturation. For additional information, open the Help menu in Epson Print CD and select Help Topics.
Designing and Printing on a Macintosh

You can use Epson Print CD to create and print a disc design with images, graphics, and text.

Designing a CD or DVD

1. Open the Applications folder, open the EPSON Print CD folder, then select EPSON Print CD.

2. To add a background image, click the background icon. You see the following window:

3. To select one of your own images, click Select Background, locate the folder your images are stored in, select the one you want, then click Open.

4. Click OK in the Adjust Background window.
5. To add text, click the \( T \) button. In the Text Settings window, type your text, then use any of the options in the window to format it. You can also use options in the Color Settings and Object Settings windows.

![Text Settings Window](image)

6. To curve a single line of text, click the text in the main window and drag the red “handle” up or down. Then adjust it using the other handles that appear.

7. When you’re finished, choose **Save as** from the File menu to save your file.

   **Note:**
   For additional help with Epson Print CD, open the Help menu in Epson Print CD and select **EPSON Print CD Help**.

---

**Printing on a CD or DVD**

After you have created your design and loaded a CD or DVD, you’re ready to print.

1. Open the File menu and select **Print**.

2. Make sure **Stylus Photo R260** is selected, then click **Print**.
You see the following:

![Print Settings](image)

**Note:**
You can only print on one CD or DVD at a time. When the copies setting is set to 2 or more, remove each CD or DVD from the tray after it has been printed, and then place the next CD or DVD on the tray (see “Inserting a CD or DVD” on page 28 for loading instructions). Then press the paper button to resume printing.

After you print, handle the CD or DVD carefully. To allow the ink to dry, wait at least 24 hours before playing the disc or inserting it in a drive. Keep printed discs away from moisture and direct sunlight.

If you need to adjust the print position or color, see “Adjusting the Print Position” on page 38 or “Adjusting the Print Density” on page 40.

**Adjusting the Print Position**

If your printed images and text are not centered or positioned the way you want, you may need to adjust the printing position. You can also use these steps to check the position before you print on a CD or DVD.

1. Place an extra ink jet-printable CD or DVD on the CD/DVD tray and insert it into the printer, as described on page 28.
2. Start Epson Print CD.
3. Select **Print** from the File menu.

4. Make sure **Stylus Photo R260** is selected, then click **Print Position Check Pattern**.

5. Click **Print**. The confirmation pattern is printed on the CD or DVD.

6. Remove the CD or DVD and measure the distance from the edge of the hole to the small cross marks labeled Top and Right. You’ll need a metric ruler with millimeters for accurate measurements.
7. Open the File menu, select Print, then select Position Adjustment. You see a screen like this:

8. Click Value Entry, then input the Top distance (from your measurement) in the Top Space box. Enter the Right distance (from your measurement) in the Right Space box.

9. Click OK to save the measurements.

**Adjusting the Print Density**

If ink smears on your printed CDs or DVDs, you may need to adjust the color saturation or ink density. CDs and DVDs from different manufacturers may absorb ink differently, so you may need to adjust the density for each type of disc. Follow these instructions to print a color saturation check pattern, and then make adjustments as necessary.

1. Start Epson Print CD.
2. Open the File menu and select Print.
3. Insert a test CD or DVD for printing, as described on page 28.
4. Make sure Stylus Photo R260 is selected, then click Print Density Check Pattern.
5. Click Print.
6. After the pattern is printed, examine the print.
If you would like to adjust the color, open the File menu, select Print, and make the Color Correction setting lighter or darker as necessary. Then, repeat steps 3 through 6 (but select either Second Time or Third Time in the Test Print Pattern section, depending on whether you're printing your second or third pattern on the disc).

**Note:**
You can print three density patterns on one disc. Each pattern is printed in a different location.

7. Remove the CD or DVD and let it dry for at least 24 hours. Then check the saturation levels again.

**Note:**
You can also use the Brightness and Contrast settings in Epson Print CD to adjust color saturation. For additional information, open the Help menu in Epson Print CD and select EPSON Print CD Help.

### Direct Printing from a Digital Camera or Mobile Phone

- Your digital camera must be compatible with PictBridge or USB DIRECT-PRINT. If it isn’t, the red ink and paper lights flash alternately when you connect your camera or phone. Epson cannot guarantee the compatibility of any cameras or phones.

- The file format of your images must be JPEG, and the size of each image must be at least 80 × 80 pixels but not more than 9200 × 9200 pixels.

### Connecting and Printing

1. Make sure your Epson Stylus Photo R260 is not printing.

2. Load the type of paper you want to use. See “Loading Paper” on page 7.
3. Connect the USB cable that came with your camera or phone to the external interface port on the front of the printer.

4. Turn your camera or phone on.

5. Use your camera or phone to select the photos you want to print, adjust any necessary settings, and print your photos. See your camera or phone manual for details.
Maintaining Your Printer

Cleaning the Print Head

If your printouts are unexpectedly light or dots or lines are missing, you may need to clean the print head. This unclogs the nozzles so they can deliver ink properly. Print head cleaning uses ink, so clean it only if quality declines.

This section explains how to clean the print head using the Head Cleaning Utility.

You can also clean the print head by holding down the H ink button on the printer for three seconds. (This only works when the red H ink light is off.)

Before you clean the print head, make sure the CD/DVD tray is not inserted in the printer, and make sure the front tray is in the paper (lower) position. See page 8 for details.

Note:
Clean the print head only when print quality declines (for example, if you see lines in your printout or colors are incorrect or missing).

Before you clean the print head, check the print head nozzles first to confirm that the print head needs to be cleaned. This saves ink. For more information, see “Checking the Print Head Nozzles” below.

Caution:
When you don’t turn on your printer for a long time, print quality can decline, so turn it on and print a few pages at least once a month to maintain good print quality.

Checking the Print Head Nozzles

1. Make sure the printer is turned on but not printing, and the red H ink light is not on. (If the red H ink light is on, you need to replace a cartridge.)

2. Make sure letter-size plain paper is loaded in the printer.

3. Windows: Right-click the printer icon on your taskbar (in the lower right corner of your screen). Select Nozzle Check.

   Macintosh OS X: Open the Applications folder and select EPSON Printer Utility2. Select SP R260 Series in the printer list, click OK, and select Nozzle Check.
You see a screen like the following:

4. Click Print or Next. The nozzle check pattern prints:

   ![Nozzle Check Pattern]

   - Print head does not need to be cleaned:
   - Print head needs to be cleaned:

5. If there are no gaps or lines, click Finish.

   If there are gaps or lines, or the test patterns are faint, click Clean. Then skip to step 3 on page 45 to clean the nozzles.

**Running the Head Cleaning Utility**

1. Make sure the printer is turned on but not printing, and the red ink light is off. (If the red ink light is flashing or on, you need to replace a cartridge; see page 46 for details.)

2. Do one of the following:
   - **Windows**: Right-click the printer icon on your taskbar (in the lower right corner of your screen). Select Head Cleaning.
Macintosh OS X: Open the Applications folder and select EPSON Printer Utility2. Select SP R260 Series in the printer list, click OK, then select Head Cleaning.

3. Follow the instructions on the screen to clean the print head.

   Cleaning takes several seconds. The printer makes noise and the green power light flashes.

   **Caution:**
   Never turn off the printer while head cleaning is in progress. You may damage it.
   Do not insert the CD/DVD tray until cleaning has finished.

4. When the green power light stops flashing, make sure paper is loaded in the printer, then do one of the following:

   - **Windows:** Click Print nozzle check pattern, then click Print.
   - **Macintosh OS X:** Click Confirmation, then click Next.

   The nozzle check pattern prints.

5. If the nozzle check pattern has no white lines or gaps (as shown below), click Finish.

   ![Nozzle pattern with no white lines or gaps]

   If the pattern has white lines or gaps (as shown below), click Clean to clean the print head again.

   ![Nozzle pattern with white lines or gaps]

   If you don't see any improvement after cleaning four times, refer to “Problems and Solutions” on page 60.

   You can also turn the printer off and wait overnight—this allows any dried ink to soften—and then try cleaning the print head again.
Replacing an Ink Cartridge

When the red ᵇ ink light flashes, one or more ink cartridges are low on ink. When the red ᵇ ink light stays on, you need to replace the cartridge(s).

When you print, you’ll also see a message on your screen telling you which cartridge is low or expended.

When a cartridge is more than six months old, you may need to replace it if printouts don’t look their best. If the quality doesn’t improve after cleaning and aligning the print head, you can replace the cartridge even if the red ᵇ ink light is off.

Checking the Ink Supply

To check the ink supply, do one of the following:

- **Windows**: Double-click the printer icon on your taskbar (in the lower right corner of your screen).
You see a window like this one:

![Ink Cartridge Window](image)

**Note:**
To see the part numbers for the ink cartridges currently installed in your printer, click **Information**.

**Macintosh OS X:** Open the Applications folder and select **EPSON Printer Utility2**. Select **SP R260 Series** in the printer list, click **OK**, then select **EPSON StatusMonitor**.

You see a window like this one:

![Cartridge Information](image)

Click a cartridge image to display information about the cartridge.

**Note:**
To update the ink cartridge status, click **Update**.

Replacing an Ink Cartridge  47
Purchasing Ink Cartridges

Epson offers two different capacity cartridges for each color in your Epson Stylus Photo R260.

Use these Epson ink cartridges within six months of installing them and before the expiration date on the package:

<table>
<thead>
<tr>
<th>Ink cartridge</th>
<th>Part Number</th>
<th>Ink cartridge</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>78 (T078120)</td>
<td>High-Capacity Black</td>
<td>77 (T077120)</td>
</tr>
<tr>
<td>Cyan</td>
<td>78 (T078220)</td>
<td>High-Capacity Cyan</td>
<td>77 (T077220)</td>
</tr>
<tr>
<td>Magenta</td>
<td>78 (T078320)</td>
<td>High-Capacity Magenta</td>
<td>77 (T077320)</td>
</tr>
<tr>
<td>Yellow</td>
<td>78 (T078420)</td>
<td>High-Capacity Yellow</td>
<td>77 (T077420)</td>
</tr>
<tr>
<td>Light Cyan</td>
<td>78 (T078520)</td>
<td>High-Capacity Light Cyan</td>
<td>77 (T077520)</td>
</tr>
<tr>
<td>Light Magenta</td>
<td>78 (T078620)</td>
<td>High-Capacity Light Magenta</td>
<td>77 (T077620)</td>
</tr>
</tbody>
</table>

Note:

You may use any combination of cartridge sizes. (If you’ve installed a 78 black cartridge, you can still use a 77 magenta cartridge, for example.)

Caution:
To ensure the best results, use genuine Epson ink cartridges and do not refill them. Other products may cause damage to your printer not covered by Epson's warranty.

You can purchase genuine Epson ink and paper from an authorized Epson reseller. To find the nearest reseller, please call 800-GO-EPSON (800-463-7766). Or you can purchase online at [http://www.epsonstore.com](http://www.epsonstore.com) (U.S. sales) or [http://www.epson.ca](http://www.epson.ca) (Canadian sales).
**Ink Cartridge Precautions**

**Warning:**
The ink cartridges are designed to contain any excess ink and prevent leakage. Careful handling is recommended, however. Do not touch the supply port of the ink cartridge or its surrounding area.

**Caution:**
To avoid damaging the printer, never move the print head by hand.

Don’t remove the cartridge label, or ink will leak.

Don’t touch the green IC chip on the side of the cartridge. This can damage the ink cartridge.

Don’t remove the green IC chip from the cartridge. Installing a cartridge without an IC chip can damage the printer.

If you remove an ink cartridge temporarily, protect the ink supply port on the bottom of the cartridge from dirt and dust. Place it in a small box, or, if you have the original packaging, return it to its own box.

**Note:**
Store ink cartridges in the same environment as the printer. Stand the cartridges upright; the label identifying the color should be on top.

You cannot print if an ink cartridge is expended. Leave the expended cartridge installed in the printer until you have obtained a replacement. Otherwise the ink remaining in the print head nozzles may dry out.

This printer uses ink cartridges equipped with IC chips that monitor the amount of ink used by each cartridge. Cartridges are usable even if they are removed and reinserted. Some ink is consumed each time cartridges are inserted, however, because the printer automatically checks their reliability.

If you remove a cartridge that is low (for which you have received an “Ink low” message), you cannot reuse it.

Ink is consumed during the following operations: print head cleaning, self-cleaning (performed when the printer is turned on), and ink charging (when an ink cartridge is installed).
Removing and Installing Ink Cartridges

Be sure you have a new ink cartridge before you begin. Once you start replacing a cartridge, you must complete all the steps in one session.

Note:
Do not open ink cartridge packages until you are ready to install the ink. Cartridges are vacuum packed to maintain reliability.

1. Make sure the CD/DVD tray is not inserted in the printer, and make sure the front tray is in the paper (lower) position. See page 8 for details.

2. Make sure the printer is turned on (the green power light should be on, but not flashing). Then open the printer cover.

3. Press and release the ink button.

   If your ink light is off, go to step 5.

   If your ink light is on or flashing, the print head moves to the left, and the cartridge that needs to be replaced stops under the mark. The green power light begins to flash. Go to step 4.

   Note:
   Don’t hold down the ink button for more than 3 seconds, or the printer will start to clean the print head.

4. Press the ink button again.

   ■ If more than one cartridge is low or expended, the next cartridge moves under the mark.

   ■ If all the low or expended cartridges have been identified, the print head moves to the ink cartridge replacement position.

   Note:
   You can also use the Status Monitor to find out which cartridge is expended. See “Checking the Ink Supply” on page 46 for more information.

Caution:
Do not touch the area shown on the right when you are changing ink cartridges.
5. Lift up the cartridge cover.

6. Press in the tab on the back of the cartridge and lift the cartridge out of the printer. Dispose of it carefully.

**Warning:**
Keep ink cartridges out of the reach of children and don’t drink the ink.

If ink gets on your hands, wash them thoroughly with soap and water. If ink gets in your eyes, flush them immediately with water. If discomfort or vision problems continue after a thorough flushing, see a doctor immediately.

7. Unwrap the new ink cartridge.

**Caution:**
Be careful not to break the hooks on the side of the ink cartridge when you remove it from the package.

Always install an ink cartridge immediately after removing the old cartridge. If the cartridge is not installed promptly, the print head may dry out and be unable to print.
8. Remove the yellow tape from the bottom of the ink cartridge.

**Caution:**
You must remove the yellow tape from the cartridge before you install it; otherwise, print quality may decline or you may not be able to print.

If you have installed an ink cartridge without removing the yellow tape, take the cartridge out of the printer, remove the yellow tape, and then reinstall it.

Do not remove the transparent seal from the bottom of the cartridge; otherwise, the cartridge may become unusable.

Do not remove or tear the label on the cartridge; otherwise, ink will leak.

9. Lower the cartridge into the holder, with the green circuit board facing the front. Then gently push the cartridge down until it clicks into place.
10. If you need to replace another ink cartridge, repeat steps 6 through 9 before continuing with step 11.

11. Close the cartridge cover.

12. Close the printer cover and press the ink button. The printer begins charging the ink delivery system.

   The green power light flashes and the printer makes noise. Charging takes about one and a half minutes. When it’s finished, the green power light stops flashing and stays on, and the red ink light goes out.

**Caution:**
Never turn off the printer while the green power light is flashing, unless the printer hasn’t moved or made noise for more than 5 minutes.

Do not insert the CD/DVD tray until ink charging is complete.

**Note:**
If the red ink light flashes after the print head moves to its home (far right) position, the ink cartridge may not be installed properly. Press the ink button two or more times (until the print head moves to the ink cartridge replacement position), open the cartridge cover, and press down the ink cartridge until it clicks into place.
Maintaining Your Printer

Aligning the Print Head

If your printouts look grainy or blurry, or you see light or dark lines, you may need to align the print head.

Note:
You may also see lines in your printouts if your cartridges are low on ink or you need to clean the print head.

Before you align the print head, make sure the CD/DVD tray is not inserted in the printer, and make sure the front tray is in the paper (lower) position. See page 8 for details.

1. Turn on the printer.

2. Make sure none of the lights are indicating errors. See page 57 for more information.

3. Load several sheets of plain, letter-size paper.

4. Do one of the following:
   - **Windows:** Right-click the printer icon on your taskbar (in the lower right corner of your screen). Select Print Head Alignment.
   - **Macintosh:** Open the Applications folder and select EPSON Printer Utility2. Select SP R260 Series in the printer list, click OK, then select Print Head Alignment.

5. Follow the instructions on the screen to print the alignment pattern. You see a window like this one:
6. Look at the four sets of patterns in your printout. For each set, look at the printed squares to determine which one in each set is the most even, with no streaks or lines, and enter its number in the corresponding box on the screen. If every square in a set contains a line or lines, select the square with the thinnest line or lines. Then click Realignment and Print to print another alignment sheet and repeat this step.

7. Click Finish to close the Print Head Alignment utility.

Cleaning the Printer

To keep your printer working at its best, you should clean it several times a year.

1. Turn off the printer, unplug the power cord, and disconnect the USB cable.
2. Remove all the paper, then use a soft brush to clean the sheet feeder.
3. If the outer case or inside of the sheet feeder are dirty, clean them with a soft cloth dampened with mild detergent. Keep the printer cover closed to prevent water from getting inside.
4. If ink accidentally gets inside the printer, wipe it off with a damp cloth in the area shown below.

**Warning:**
Don’t touch the gears or any other parts inside the printer.

**Caution:**
Never use a hard or abrasive brush, or benzine, alcohol, or paint thinner for cleaning; they can damage the printer components and case. Don’t get water on the printer components and don’t spray or apply lubricants, oils or grease inside the printer. Don’t use any cleaning sheets included with special paper; they may jam inside the printer.
**Transporting the Printer**

If you need to ship your printer, you must prepare it for transportation by packing the printer in its original box or one of a similar size.

**Caution:**
When storing or transporting the printer, do not tilt it, stand it up vertically, or turn it upside down. Otherwise, ink may leak from the cartridges.

Leave the ink cartridges installed. Removing the cartridges can dehydrate the print head and may prevent the printer from printing.

1. Turn on the printer. Wait until the print head returns to the home (far right) position, then close the printer cover.

2. Turn off the printer and unplug its power cord. Then disconnect the power cord and USB cable from the printer.

3. Open the printer cover. Secure the print head with tape, as shown below, then close the printer cover.

4. Remove any paper from the printer, then push down the paper support extension and close the paper support.

5. Repack the printer and its attachments in the original box using the protective materials that came with them.

Keep the printer level as you transport it.

After transporting the printer, remove the tape securing the print head. Then plug in your printer, turn it on, and test it. If you notice a decline in print quality, clean the print head (see page 43); if output is grainy or blurry, align the print head (see page 54).
Solving Problems

See “Diagnosing Printer Problems” below to help determine what the cause of your printer problem may be. If you cannot solve the problem, see “Where To Get Help” on page 69.

Diagnosing Printer Problems

First, check the printer’s lights (see below) or run a printer check (see page 59).

<table>
<thead>
<tr>
<th>Lights</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green power light flashes</td>
<td>The printer is receiving a print job, replacing an ink cartridge, charging ink, or cleaning the print head.</td>
</tr>
<tr>
<td>Red paper out light is on and green power light flashes</td>
<td>If you’re printing on paper, your paper ran out or multiple pages have fed at once. Make sure you push the tray lever up to set the front tray to the paper (lower) position. Then, load more paper and press the paper button to resume printing. If you’re printing on a CD or DVD, the CD/DVD tray is not inserted. Follow the instructions beginning on page 28 to insert the tray, then press the paper button.</td>
</tr>
<tr>
<td>Red paper out light and green power light flash</td>
<td>If you’re printing on paper, it is jammed in the printer. Press the paper button to eject the paper. If that doesn’t work, turn off the printer, open the cover, and pull the paper out from the front, including any torn pieces. Then turn on the printer, reload paper, and press the paper button. If you’re printing on a CD or DVD, the CD/DVD tray has not ejected. Pull out the tray and press the paper button.</td>
</tr>
<tr>
<td>Red ink light flashes</td>
<td>One of the cartridges is nearly expended. Check the message that appears on your screen to determine which cartridge is nearly expended or follow the instructions in “Checking the Ink Supply” on page 46. Make sure you have a replacement cartridge.</td>
</tr>
<tr>
<td>Lights</td>
<td>Explanation</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Red △ ink light and green ○ power light are on</td>
<td>One of the cartridges is expended or not installed. Make sure you have a replacement cartridge, then follow the steps in “Replacing an Ink Cartridge” on page 46 to install it. If you have just installed a new cartridge, it may be incompatible with the printer or incorrectly installed. Reinstall it or replace it with the correct cartridge, as described on page 46.</td>
</tr>
<tr>
<td>Green ○ power light is off; red △ paper out and △ ink lights flash</td>
<td>Paper may be blocking movement of the print head. Turn off the printer, then open the cover and remove any jammed paper or other foreign objects. Turn the printer back on again. If the lights are still on, contact Epson as described in “Where To Get Help” on page 69.</td>
</tr>
<tr>
<td>Green ○ power light flashes; red △ paper out and △ ink lights flash rapidly</td>
<td>The front tray is not in the correct position. Before you turn on the printer or print on paper, push the tray lever up to set the front tray to the paper (lower) position. Before you print on a CD or DVD, pull the tray lever down to set the front tray to the CD/DVD position.</td>
</tr>
<tr>
<td>Red △ paper out and red △ ink light flash alternately and green ○ power light is on</td>
<td>An unsupported device is connected to the EXT. I/F USB port. Only devices compatible with PictBridge or USB DIRECT-PRINT can be connected to this port. See page 41 for more information.</td>
</tr>
<tr>
<td>Red △ paper out and red △ ink light flash alternately and green ○ power light is off</td>
<td>The printer may have an internal error. Turn off the printer, wait a few seconds, and turn it on again. If the lights are still flashing, contact Epson as described in “Where To Get Help” on page 69.</td>
</tr>
</tbody>
</table>
Running a Printer Check

You can run a printer check to determine whether a problem comes from the printer or some other source.

Before you run a printer check, make sure the CD/DVD tray is not inserted in the printer, and make sure the front tray is in the paper (lower) position. See page 8 for details.

1. Make sure no lights are indicating errors. See page 57 for more information.
2. Turn off both the printer and computer. Then disconnect the USB cable from the printer.
3. Make sure letter-size plain paper is loaded in the printer.
4. Hold down the paper button, then press the power button. Continue holding down the paper and power buttons until the green power light starts to flash, then release them.

5. A nozzle check pattern prints. (If the pattern has gaps, you need to clean the print head as described on page 43.)
   - If the test page prints, the problem probably lies in your software settings, USB cable, or computer, or your software may not be installed correctly.
   - If the test page doesn’t print, you may have a problem with your printer.

Try the suggestions in “Problems and Solutions” below. If nothing works, contact Epson as described in “Where To Get Help” on page 69.

6. Turn off the printer, reconnect the USB cable, then turn on your printer and computer.
Problems and Solutions

Tip:
If you don’t find the information you’re looking for in this section, please check the on-screen User’s Guide. You may find additional information in the User’s Guide that will help you solve your problem.

Setup and Software Installation Problems

Tip:
Periodically, it’s a good idea to check Epson’s support website at epson.com/support for free updates to your Epson Stylus Photo R260 printer software. Download instructions are posted for your convenience. With Windows, you can click the Driver Update button on the Maintenance tab in your Windows printer software or click Start or , select Programs or All Programs, select EPSON, and click EPSON Stylus Photo R260 Series Driver Update.

The printer makes noise after ink cartridge installation.

- The first time you install ink cartridges, the printer must charge its print head for a minute or so. Wait until charging finishes before you turn off the printer, or it may charge improperly and use excess ink the next time you turn it on.
- Make sure the ink cartridge cover is closed completely and no packing material remains in the printer. Turn off the printer, wait a moment, then turn it back on to clear the error.

You’re having problems installing the printer software.

- Carefully follow the installation instructions on the Start Here sheet. Do not connect your printer to the computer until you are instructed to do so. When connecting your printer, make sure the USB cable is connected securely to the printer and the computer. Also make sure your system meets the requirements shown on page 70.
- Close your other programs, including any screen savers and virus protection software, and install again.
- If you are using a Macintosh and you do not see the printer name in the Format for menu on the Page Setup screen, you may need to set up your printer in the Printer Setup Utility or Print Center. See the Start Here sheet for instructions.
For Windows 2000, if you see an error message or your software doesn't install correctly, you may not have software installation privileges. Contact your System Administrator.

Make sure the USB Controller is working properly in Device Manager. See your Windows help system for details. If it's not working, contact your computer manufacturer.

If you’re printing on a network, see your on-screen *User’s Guide* for instructions on configuring your printer for use on a network.

**Printer Problems**

**The printer is on, but nothing prints.**

- Make sure the USB cable is connected securely and that the cable meets the system requirements on page 70.
- Run a printer check as described on page 59. If the check page prints, make sure your software is installed correctly.
- If you’re printing on a network, you need to set up your printer for network printing, as described in your on-screen *User’s Guide*.
- If you print continuously for an extended period, the paper may temporarily stop feeding or the print head carriage may pause for a while to prevent the printer mechanism from overheating and being damaged. If this happens, you can continue to print but Epson recommends that you stop and leave the printer on for about 30 minutes. After 30 minutes, turn the printer off and on and it should print at normal speed.

**The printer sounds as though it is printing, but nothing prints.**

- If you’re using Windows, make sure your printer is selected. For Macintosh OS® X, make sure your printer is selected in the Page Setup and Print windows.
- Make sure the print head nozzles are not clogged. To clean the print head, see page 43.
- Make sure the printer software settings are appropriate for the paper size you’re using.
- The printer won’t operate properly if it’s tilted or at an angle. Place it on a flat, stable surface that extends beyond the printer base in all directions.
Your printer makes noise when you turn it on or after it has been sitting for awhile.
Your printer is performing routine maintenance.

**Printing is too slow.**
Make sure your system meets the requirements listed on page 70. If you’re printing a high-resolution image, you need more than the minimum requirements listed. You may also need to:
- Clear space on your hard drive or run a defragmentation utility.
- Close open programs that you’re not using.
- Increase your system’s memory (RAM).

For the fastest printing, try these tips:
- Set the Quality Option to Draft (Windows) or the Quality/Speed slider to Speed (Macintosh).
- If your printer is connected to a hub, disconnect USB devices that you’re not using.

**Note:**
Borderless printing takes longer, especially near the edges of the paper.

**Print Quality Problems**

You see banding (light lines).
- The print head nozzles may need cleaning; see page 43 for instructions.
- Select a higher print quality and turn off High Speed mode; see page 12 (Windows) or page 16 (Macintosh) for instructions.
- Make sure the Type (Windows) or Media Type (Macintosh) setting matches the paper you loaded; see page 19 for guidelines.
- Make sure the printable side of the paper is face-up. It’s usually brighter or whiter.
- The ink cartridges may need replacing; see page 46 for instructions.
- Run the Print Head Alignment utility; see page 54 for instructions.
Your printout is blurry or smeared.

■ Make sure you load paper with the printable side face-up. The printable side is usually the brighter or whiter side of the paper.

■ Make sure your paper isn’t damp or curled, or loaded face-down (the printable side should be face-up). If it’s damp or curled, reload a new stack of paper.

■ When printing on special paper, check the instructions in the paper package. You may need to use an included support sheet or load your paper one sheet at a time.

■ Use Epson papers to ensure proper saturation and absorption of genuine Epson inks.

■ Make sure your paper meets the specifications listed in the on-screen User’s Guide.

■ Run the Print Head Alignment utility; see page 54 for instructions.

■ Remove each sheet from the output tray after printing.

Your printout is faint or has gaps.

■ The print head nozzles may need cleaning; see page 43 for instructions.

■ The ink cartridges may be old or low on ink. To replace an ink cartridge, see page 46.

■ Make sure the paper Type (Windows) Media Type (Macintosh) setting matches the paper you loaded; see page 19 for guidelines.

■ Make sure your paper isn’t damp or curled, or loaded face-down (the printable side should be face-up). If it’s damp or curled, reload a new stack of paper. For best results, use genuine Epson paper.
Your printout is grainy.

- Try using a higher quality paper.
- Select a higher print quality setting; see page 12 (Windows) or page 16 (Macintosh) for instructions.
- Run the Print Head Alignment utility. See page 54 for instructions.
- You may need to increase the image resolution or print it in a smaller size; see your software documentation.

You see wrong or missing colors.

- Clean the print head; see page 43 for instructions.
- Clear the Grayscale setting in your printer software (for Windows). Change the ink setting in your printer software to Color (for Macintosh).
- The ink cartridges may be old or low on ink; see page 46.
- If you're using Windows, try turning off PhotoEnhance. Also check if you're using a special effect that alters image colors, like Sepia.

  **Note:**
  Automatic photo correction is on by default. However, due to the complexity and nature of some photographs, not all images can be corrected.

- Try changing the Gamma setting; see your on-screen User’s Guide for more information.

- Your printed colors can never exactly match your on-screen colors. However, you can use a color management system to get as close as possible. You can also use your printer’s color management features. See your on-screen User’s Guide for more information.

- After you print, the colors on your printout will take some time to set as the ink dries. During this time, the colors may look different than you expect. To reduce the drying time, avoid stacking your prints on top of each other.

**Problems With Paper or CD/DVD Tray Feeding**

Paper doesn’t eject fully or is wrinkled.

- If the paper doesn’t eject fully, you may have set the wrong paper size. Press the paper button to eject the paper, then select the correct paper size.
- If it’s wrinkled when it ejects, the paper may be damp or too thin.
Paper doesn’t feed correctly or jams in the printer.

- Make sure the paper support extension is pulled up.
- If paper doesn’t feed, remove it from the sheet feeder, reload it against the right edge, then slide the left edge guide against the paper.
- If multiple pages feed at once, remove the paper from the sheet feeder, fan the edges to separate the sheets, and carefully reload it.
- If paper jams, press the paper button to clear the jam. If that doesn’t work, open the cover and remove any jammed paper, including small pieces that may have torn off. Reload the paper and press the paper button.

If your paper loads incorrectly or jams frequently:

- Use new, smooth, high-quality paper, loaded printable side up. Don’t load paper above the arrow mark on the left edge guide.
- Place the paper against the right edge and slide the left edge guide against it, but not too tight.
- Store paper flat to prevent curling.

The CD/DVD tray is ejected or not fed correctly when a print job is sent.

- Reinsert the CD/DVD tray correctly. See page 28.
- If the tray is ejected when you start a print job, the printer is not ready. Wait until you see a message on your screen asking you to insert the tray. Then reinsert the tray and press the paper button.

CD/DVD Printing Problems

Images and text are not centered on the CD/DVD.

Adjust the Print position as described on page 33 (Windows) or page 38 (Macintosh).

Ink smears on the CD/DVD or printing is too light.

- Make sure you’re using ink jet-printable CDs or DVDs.
- Handle the disc carefully and allow the ink to dry for at least 24 hours before playing the disc or inserting it in a drive.
- Adjust the print density as described on page 35 (Windows) or page 40 (Macintosh).
- Adjust the brightness or contrast. See the Epson Print CD on-screen help.
Printed CDs or DVDs are dirty.
Clean the rollers as described on page 28.

The CD/DVD won’t feed into the printer.
Make sure you gently insert the CD/DVD tray along the base of the front tray until the arrow marks on the CD/DVD tray and the front tray match each other. Make sure both sides of the CD/DVD tray slide underneath the brackets on the front tray. See page 28.

**Miscellaneous Printout Problems**

The image is inverted.
Turn off the *Mirror Image* setting in the your printer software or your application program. (If you're printing on Epson Iron-on Cool Peel Transfer paper, the image *should* be inverted.)

The printer prints blank pages.
- If you're using Windows, make sure your printer is selected. For Macintosh OS X, make sure your printer is selected in the Page Setup and Print windows.
- The print head nozzles may need cleaning; see page 43.

The margins are incorrect.
- Make sure the paper settings are correct for your paper size.
- Make sure the paper is positioned all the way to the right of the sheet feeder. Slide the left edge guide against the paper.
- See your software documentation for instructions on choosing the correct margins for your paper size. The margins must be within the printable area of the page. See “Printable Area” in the “ Specifications” section of your on-screen User’s Guide.

The image size or position is incorrect.
- Make sure the paper and layout options are set correctly.
- Your images may not match the width/height proportions of the paper size or layout you're using, and may be cropped to fit.
You see incorrect characters.
■ Make sure the USB cable is securely connected and meets the system requirements on page 70. Then try printing again.
■ If you're using Windows, make sure your printer is selected. For Macintosh OS X, make sure your printer is selected in the Page Setup and Print windows.
■ If you're using a switch box or USB hub with your printer, connect the printer directly to your computer instead.

Too many copies are printing.
Make sure that the Copies option in your printer software or program is not set for multiple copies.

Uninstalling Printer Software
You may need to uninstall and then reinstall your printer driver and utilities. For example, this might be necessary when you upgrade your operating system. You don’t need to uninstall Epson Print CD, PhotoImpression, or your on-screen User’s Guide.

Note:
Do not turn off or disconnect the printer while you are uninstalling the software.

Windows
1. Turn off the printer and disconnect its USB cable.
2. Click Start or , and select Programs or All Programs.
3. Point to Epson or Epson Printers, then select Epson Printer Software Uninstall.
   With Windows Vista, click Continue, then go to step 4.
4. In the next window, select EPSON Stylus Photo R260 Series, and click OK. Then follow the on-screen instructions.
5. Restart your computer, then see the Start Here sheet to reinstall your software.
**Macintosh**

1. Quit all running applications.
2. Insert the Epson printer software CD-ROM into your Macintosh.
3. Open the Epson CD-ROM desktop icon.
4. Double-click the **English** folder, then double-click the **OSX** folder.
   
   **Note:**
   You may have to scroll down to see these folders.
5. Double-click the **Installer** icon.
   
   **Note:**
   If the Authenticate dialog box appears, enter your password or phrase and click **OK**.
6. When the Installer window appears, select **Uninstall** from the pop-up menu in the upper left and click **Uninstall**.
7. Follow the on-screen instructions to uninstall the printer software.
   
   **Note:**
   If the name of your printer remains in the Print Center or Printer Setup Utility, select it from Printer List and click **Delete**.
8. Restart your Macintosh, then see the **Start Here** sheet to reinstall your software.
Where To Get Help

Epson Technical Support

Epson provides these technical support services:

Internet Support
Visit Epson's support website at epson.com/support and select your product for solutions to common problems. You can download drivers and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your questions.

Speak to a Support Representative
Before you call Epson for support, please have the following information ready:

■ Product name (Epson Stylus Photo R260)
■ Product serial number (located on the label in back)
■ Proof of purchase (such as a store receipt) and date of purchase
■ Computer configuration
■ Description of the problem

Then call:

■ U.S.: (562) 276-7282, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM, Saturday.
■ Canada: (905) 709-2567, 6 AM to 6 PM, Pacific Time, Monday through Friday.

Toll or long distance charges may apply.

Purchase Supplies and Accessories

You can purchase genuine Epson ink and paper from an Epson authorized reseller. To find the nearest reseller, call 800-GO-EPSON (800-463-7766). Or you can purchase online at http://www.epsonstore.com (U.S. sales) or http://www.epson.ca (Canadian sales).
Requirements and Notices

Windows System Requirements

To use your printer and its software, your system should have:

■ A Microsoft® Windows compatible PC with a Pentium®-equivalent processor (800 MHz or faster recommended)
   512MB RAM for Windows Vista (1GB recommended)
■ 300MB free hard disk space (550MB or more recommended)
■ 4x or faster CD-ROM or DVD drive for installing the printer software
■ A Windows-compliant USB port and shielded USB “AB” cable up to 6.5 feet (2 meters) long. Using an improperly shielded USB cable may cause the printer to malfunction.

Macintosh System Requirements

To use your printer and its software, your system should have:

■ An Apple Macintosh PowerPC® or Intel® Core™ processor
■ Macintosh OS X 10.2.8, or 10.3.9 to 10.4.x
■ 256MB RAM (512MB recommended)
■ 300MB free hard disk space (550MB recommended)
■ 4x or faster CD-ROM or DVD drive for installing the printer software
■ A USB port and shielded USB “AB” cable up to 6.5 feet (2 meters) long. Using an improperly shielded USB cable may cause the printer to malfunction.
Important Safety Instructions

Before using your printer, read the following safety instructions to make sure you use the printer safely and effectively:

- Be sure to follow all warnings and instructions marked on the printer.
- Do not block or cover the openings in the printer’s case or insert objects through the slots. Leave enough room around the printer for sufficient ventilation.
- Use only the type of power source indicated on the printer’s label.
- Use only the power cord that comes with the printer. Use of another cord may result in fire or electric shock. Do not use the cord with any other equipment.
- Be sure your AC power cord meets the relevant local safety standard.
- Connect all equipment to properly grounded power outlets. Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on and off.
- Avoid electrical outlets controlled by wall switches or automatic timers.
- Keep your printer and computer system away from potential sources of electromagnetic interference, such as loudspeakers or cordless telephone base units.
- Do not use a damaged or frayed power cord.
- If you use an extension cord with the printer, make sure the total ampere rating of the devices plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s ampere rating.
- Except as specifically explained in your documentation, do not attempt to service the printer yourself.
- Unplug the printer and refer servicing to qualified service personnel under the following conditions: If the power cord or plug is damaged; if liquid has entered the printer; if the printer has been dropped or the case damaged; if the printer does not operate normally or exhibits a distinct change in performance. Adjust only those controls that are covered by the operating instructions.
- When connecting the printer to a computer or other device with a cable, ensure the correct orientation of the connectors. Each connector has only one correct orientation. Inserting a connector in the wrong orientation may damage both devices connected by the cable.
- Place the printer on a flat, stable surface that extends beyond the printer base in all directions. The printer will not operate properly if it is tilted or at an angle.
- When storing or transporting the printer, do not tilt it, stand it on its side, or turn it upside down. Otherwise, ink may leak from the cartridges.
■ Leave enough space in front of the printer for the paper to be fully ejected.
■ Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
■ Do not place the printer near a radiator or heating vent or in direct sunlight.
■ Place the printer near a wall outlet where the plug can be easily unplugged.
■ Do not put your hand inside the printer or touch the ink cartridges during printing.
■ Do not use aerosol products that contain flammable gases inside or around this product. Doing so may cause fire.
■ Do not move the print head by hand; otherwise, you may damage the printer.
■ Always turn the printer off using the \textit{power} button. When this button is pressed, the green \textit{power} light flashes. Do not unplug the printer or turn off the power to the outlet until the green \textit{power} light stops flashing.
■ Before transporting the printer, make sure that the print head is in the home (far right) position and the ink cartridges are in place.
■ Leave the ink cartridges installed. Removing the cartridges can dehydrate the print head and may prevent the printer from printing.
■ Turn off and unplug the printer before cleaning. Clean with a damp cloth only. Do not spill liquid on the printer.

\textbf{Ink Cartridge Safety Instructions}

■ Keep ink cartridges out of the reach of children and don’t drink the ink.
■ Do not shake ink cartridges after opening their packages; this can cause leakage.
■ Be careful when you handle used ink cartridges, as there may be some ink remaining around the ink supply port. If ink gets on your skin, wash the area thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.
■ Do not remove or tear the label on the cartridge; this can cause leakage.
■ Install the ink cartridge immediately after you remove it from its package. Leaving the cartridge unpacked for a long time before use can result in reduced print quality.
■ Do not use an ink cartridge beyond the date printed on the package. For best results, use up the ink cartridges within six months of first installing them.
■ Do not dismantle the ink cartridges or try to refill them. This could damage the print head.
■ After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature for at least three hours before using it.
Store ink cartridges in a cool, dark place.

Do not touch the green IC chip on the side of the cartridge. This may affect normal operation and printing.

The IC chip on this ink cartridge retains a variety of cartridge-related information such as the ink cartridge status, so that the cartridge may be removed and reinserted freely. However, each time the cartridge is inserted, some ink is consumed because the printer automatically performs a reliability check.

If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in the same environment as the printer. Note that there is a valve in the ink supply port, making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area.

Store ink cartridges with their labels facing upward. Do not store cartridges upside down.

---

**FCC Compliance Statement**

*For United States Users*

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

WARNING: The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this.
device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user's authority to operate the equipment.

For Canadian Users
This Class B digital apparatus complies with Canadian ICES-003.
_Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada._

Declaration of Conformity

According to 47CFR, Part 2 and 15 for Class B Personal Computers and Peripherals; and/or CPU Boards and Power Supplies used with Class B Personal Computers:

We: Epson America, Inc.
Located at: MS: 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806-2469
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative unit tested and found to be compliant with the standards. Records maintained continue to reflect the equipment being produced can be expected to be within the variation accepted, due to quantity production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Trade Name: Epson
Type of Product: Ink Jet Printer
Model: B411B
Epson America, Inc. Limited Warranty

What Is Covered: Epson America, Inc. ("Epson") warrants to the original retail purchaser that the Epson printer covered by this limited warranty statement, if purchased and operated only in the United States or Canada, will be free from defects in workmanship and materials for a period of one (1) year from the date of original purchase. For warranty service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: Should your Epson printer prove defective during the warranty period, please call the Epson Connection® at (562) 276-7282 (U.S.) or (905) 709-2567 (Canada) for warranty repair instructions and return authorization. An Epson service technician will provide telephone diagnostic service to determine whether the printer requires service. If service is needed, Epson will, at its option, exchange or repair the printer without charge for parts or labor. If Epson authorizes an exchange for the defective unit, Epson will ship a replacement printer to you, freight prepaid, so long as you use an address in Canada or the U.S. (excluding Puerto Rico and U.S. Possessions). Shipments to other locations will be made freight collect. You are responsible for securely packaging the defective unit and returning it to Epson within five (5) working days of receipt of the replacement. Epson requires a debit or a credit card number to secure the cost of the replacement printer in the event that you fail to return the defective one. If your printer is being repaired, Epson will direct you to send your printer to Epson or its authorized service center, where the printer will be fixed and sent back to you. You are responsible for packing the printer and for all costs to and from the Epson authorized service center. When warranty service involves the exchange of the printer or a part, the item replaced becomes Epson property. The replacement printer or part may be new or refurbished to the Epson standard of quality, and, at Epson’s option, may be another model of like kind and quality. Epson’s liability for replacement of the covered printer will not exceed the original retail selling price of the covered printer. Exchange products and parts assume the remaining warranty period of your original product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty does not apply to refurbished or reconditioned products. This warranty covers only normal use in the United States and Canada. Using this product for continuous production or similar high duty purposes is not considered normal use; damage, maintenance or service from such use will not be covered under this warranty. This warranty is not transferable. This warranty does not cover any color change or fading of prints or reimbursement of materials or services required for reprinting. This warranty does not cover damage to the Epson product caused by parts or supplies not manufactured, distributed or certified by Epson. This warranty does not cover ribbons, ink cartridges or third party parts, components, or peripheral devices added to the Epson product after its shipment from Epson, e.g., dealer or user-added boards or components. Epson is not responsible for warranty service should the Epson label or logo or the rating label or serial number be removed or should the product...
fail to be properly maintained or fail to function properly as a result of misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as fire, flood, and lightning, improper electrical current, software problems, interaction with non-Epson products, or service other than by an Epson Authorized Servicer. If a claimed defect cannot be identified or reproduced, you will be held responsible for the costs incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE. UNLESS STATED HEREIN, ANY STATEMENT OR REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM ARE VOID. EXCEPT AS PROVIDED IN THIS WRITTEN WARRANTY, NEITHER EPSON AMERICA, INC. NOR ITS AFFILIATES SHALL BE LIABLE FOR ANY LOSS, INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions. Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above limitations and exclusions may not apply to you. This warranty gives you specific legal rights and you may have other rights which vary from jurisdiction to jurisdiction.

To find the Epson Authorized Reseller nearest you, visit our website at: http://www.epson.com.

To find the Epson Customer Care Center nearest you, visit http://support.epson.com.

You can also write to:
Epson America, Inc., P.O. Box 93012, Long Beach, CA 90809-3012
Index

A
Accessories, 69
Aligning print head, 54 to 55
Automatic mode, Macintosh, 16

B
Banding, 62 to 63
Basic printing
  Macintosh, 15 to 18
  Windows, 11 to 14
Blank pages, 66
Blurry images, 63
Borderless expansion
  adjusting, Macintosh, 27
  adjusting, Windows, 25
Borderless printing, 20 to 27

C
Cable, USB, 70
Camera, printing from, 41 to 42
Cancelling printing
  Macintosh, 18
  Windows, 14
CDs
  adjusting print density, Macintosh, 40 to 41
  adjusting print density, Windows, 35
  adjusting print position, Macintosh, 38 to 40
  adjusting print position, Windows, 33 to 34

CDs (continued)
  designing, Macintosh, 36 to 37
  designing, Windows, 31 to 32
  feeding problems, 65
  inserting in printer, 28 to 31
  printing on, 28 to 41
  printing problems, 65 to 66
Cell phone, printing from, 41 to 42
Characters, incorrect, 67
Checking printer, 59
Cleaning
  print head, 43 to 45
  printer, 55
  rollers, 28
  sheets, 55
Color management
  Macintosh, 16
  Windows, 13
Color problems, 64
ColorSync, 16
Copies setting, Macintosh, 16

D
Declaration of Conformity, 74
Default printer settings, Windows, 14
Digital camera, printing from, 41 to 42
Displaying photos, 21
DVDs, see CDs
E
Edge-to-edge printing, 20 to 27
Epson
accessories, 69
help, 69
ink, 48
papers, 10, 19, 20
Print CD, Macintosh, 36 to 41
Print CD, Windows, 31 to 35
Store, 69
warranty, 75 to 76
Exif Print, 5
Expansion
borderless, Macintosh, 27
Borderless, Windows, 25

F
Faint images, 63
FCC Compliance, 73 to 74
Full bleed printing, 20 to 27

G
Gamma setting, Macintosh, 16
Grainy prints, 64

H
Head Cleaning utility, 44 to 45
Help, Epson, 69

I
Incorrect characters, 67
Incorrect colors, 64
Ink cartridge
level of ink in, 46
ordering, 48
replacing, 46 to 53
safety instructions, 51, 72 to 73

J
Jams, paper, 65

L
Layout problems, 66
Layout settings
Macintosh, 16
Windows, 13

M
Macintosh
basic printing, 15 to 18
system requirements, 70
uninstalling software, 68
Maintaining printer, 43 to 56
Marginless printing, 20 to 27
Margins, incorrect, 66
Media Type setting, 19
Mirror image, 66
Mobile phone, printing from, 41 to 42
Monitoring ink level
Macintosh, 47
Windows, 46
Moving printer, 56

N
Noise, printer, 62
Nozzle check, 43 to 44
Orientation setting
Macintosh, 15
Windows, 12

Page Setup, Macintosh, 15
Page
Epson, 10, 19, 20
loading, 7 to 9
orientation, Macintosh, 15
orientation, Windows, 12
size, Macintosh, 15
size, Windows, 12
Paper Type setting, 19
Phone, printing from, 41 to 42
Photos
displaying and storing, 21
printing, 20 to 27
PictBridge, 41
Print CD software
Macintosh, 36 to 41
Windows, 31 to 35
Print dialog box
Macintosh, 15
Windows, 11
Print head
aligning, 54 to 55
cleaning, 43 to 45
Print Head Alignment utility, 54 to 55
Print quality problems, 62 to 64
Print window
Macintosh, 15
Windows, 11
Printer
check, 59
cleaning, 55
maintaining, 43 to 56
noise, 62
problems, 57 to 67
transporting, 56
Printing
basic, 11 to 18
borderless photos, 20 to 27
CDs and DVDs, 28 to 41
controlling, Macintosh, 18
controlling, Windows, 14
Printing, slow, 62
Problems
CD printing, 65 to 66
CD/DVD feeding, 65
color, 64
installing software, 60 to 61
miscellaneous, 66 to 67
paper feeding, 64 to 65
print quality, 62 to 64
printer, 57 to 67
Quality Option setting, 12
Quality/Speed setting, 16
Safety instructions, 71 to 73
Slow printing, 62
Software
Epson Print CD, Macintosh, 36 to 41
Epson Print CD, Windows, 31 to 35
problems, solving, 60 to 61
uninstalling, 67 to 68
Stopping printing
Macintosh, 18
Windows, 14
Storing photos, 21
System requirements, 70
T
Transporting printer, 56
Troubleshooting, 57 to 69
Type setting, 19

U
Uninstalling software, 67 to 68
USB
cable, 70
port for camera, 42
port for phone, 42
Utilities
Head Cleaning, 44 to 45
Nozzle Check, 43 to 44
Print Head Alignment, 54 to 55

W
Warranty, 75 to 76
Windows
basic printing, 11 to 14
Photo Gallery, 21
Picture and Fax Viewer, 23
system requirements, 70
uninstalling software, 67
Epson Paper and Ink—Designed to Work Together

You can purchase genuine Epson paper and ink online at www.epsonstore.com (U.S. sales) or www.epson.ca (Canadian sales). Or you can purchase from an Epson authorized retailer. To find the nearest retail store, call 800-GO-EPSON (800-467-7669).

Epson Papers

Epson papers are specially coated to work with genuine Epson inks for optimal image quality and maximum longevity.

<table>
<thead>
<tr>
<th>Paper category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photo Papers</td>
<td>For lab quality photos—from everyday snapshots to professional portraits. Available in glossy, semi-gloss, and lustre finishes.</td>
</tr>
<tr>
<td>Matte Papers</td>
<td>Matte paper with a smooth or textured finish for professional quality photos, brochures, or art projects.</td>
</tr>
<tr>
<td>Scrapbooking Papers</td>
<td>Acid-free, lignin-free paper for archival quality photos, backgrounds, headlines, and other page elements.</td>
</tr>
<tr>
<td>Fine Art Papers</td>
<td>Luxurious weight, texture, and finish give these fine art papers a true museum quality appearance.</td>
</tr>
<tr>
<td>Specialty Papers</td>
<td>For projects that showcase your favorite photos, including greeting cards, iron-on transfers, and transparencies.</td>
</tr>
</tbody>
</table>

Ultra Premium Photo Paper Glossy

Ideal for framing and for long-lasting, professional quality prints. It has an ultra smooth and bright white finish, and is Epson’s heaviest weight glossy paper for standard-size printers.

Genuine Epson Inks

Look for the numbers below to find your cartridges. It’s as easy as remembering your number!

78 Black T079120
78 Magenta T079220
78 Cyan T079320
78 Lt. Magenta T079620
78 Lt. Cyan T079520
78 Yellow T079420

Try the High Capacity 77 cartridges available at www.epson.com/highcapacity (U.S. sales) or www.epson.ca (Canadian sales).

To learn more, visit: www.epson.com/storyR260

See the inside back cover for a great new way to share your memories—StoryTeller!
Epson Paper and Ink—Designed to Work Together

You can purchase genuine Epson paper and ink online at www.epsonstore.com (U.S. sales) or www.epson.ca (Canadian sales). Or you can purchase from an Epson authorized retailer. To find the nearest retail store, call 800-GO-EPSON (800-467-7669).

Epson Papers

Epson papers are specially coated to work with genuine Epson inks for optimal image quality and maximum longevity.

<table>
<thead>
<tr>
<th>Paper category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photo Papers</td>
<td>For lab quality photos—from everyday snapshots to professional portraits. Available in glossy, semi-gloss, and luster finishes.</td>
</tr>
<tr>
<td>Matte Papers</td>
<td>Non-glare paper with a smooth or textured finish for professional quality photos, brochures, or art projects.</td>
</tr>
<tr>
<td>Scrapbooking Papers</td>
<td>Acid-free, lignin-free paper for archival quality photos, backgrounds, headlines, and other page elements.</td>
</tr>
<tr>
<td>Fine Art Papers</td>
<td>Luxurious weight, texture, and finish give these fine art papers a true museum quality appearance.</td>
</tr>
<tr>
<td>Specialty Papers</td>
<td>For projects that showcase your favorite photos, including greeting cards, iron-on transfers, and transparencies.</td>
</tr>
</tbody>
</table>

Ultra Premium Photo Paper Glossy

Ideal for framing and for long lasting, professional quality prints. It has an ultra smooth and bright white finish, and is Epson’s heaviest weight glossy paper for standard-size printers.

Genuine Epson Inks

Look for the numbers below to find your cartridges. It’s as easy as remembering your number!

- 78 Black T078120
- 78 Magenta T078320
- 78 Lt. Magenta T078620
- 78 Yellow T078420
- 78 Cyan T078220
- 78 Lt. Cyan T078520

Try the High Capacity 77 cartridges available at www.epson.com/highcapacity (U.S. sales) or www.epson.ca (Canadian sales).

To learn more, visit: www.epson.com/storyR260

See the inside back cover for a great new way to share your memories — StoryTeller!